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Introduction

« The Rugged TROLL Instrument measures level and temperature.

« Useitin natural groundwater, surface water, industrial waters, and other installations.

What you'll find in this manual...
+ Setup, calibration, and deployment instructions
- Maintenance information

+  Modbus and SDI-12 programming overview

Instrument details...
Serial number location
« The serial number is engraved on the instrument housing.

« Itis also programmed into the instrument and is displayed when the instrument is connected to the
VuSitu mobile app ora computer running Win-Situ Software.

Certification

« See the Declarations of conformity at end of this manual.

Unpacking and inspection

«  Your instrument was carefully inspected before shipping.

«  Check for any physical damage sustained during shipment.
+ Notify In-Situ and file a claim with the carriers involved if there is any shipping damage.

« Accessories may be shipped separately. Inspect them for physical damage and verify that all of the
items you ordered are present.

Warranty

See the product specification tables for warranty information.

Contact information

In-Situ

Mailing and shipping 221 East Lincoln Avenue

address: Fort Collins, CO 80524-2533 U.S.A.
Phone: 970-498-1500 (international & domestic)
Fax: 970-498-1598

Internet: www.in-situ.com

Support: 800-446-7488 (U.S.A. & Canada)



Product specifications

Rugged TROLL 100 and 200 specifications

Temperature ranges'

Operational: 0 to 50° C (32-122°F)
Storage: -40-80° C (-40-176° F)
Calibrated: 0-50° C (32-122°F)

Diameter 2.62cm (1.03in.)

Length 14.43 cm (5.68in.)

Weight 137 g (0.30 1b)

Materials Titanium body; Delrin nose cone, hanger, backend
Rugged TROLL 100: USB or RS232 via docking
station

Output options Rugged TROLL 200: USB or RS232 via docking

station; Modbus/RS485 or SDI-12 via Rugged TROLL
200 Cable; Wireless TROLL Com

Battery type & life”

3.6V lithium; 10 years or 2M readings

External power

Rugged TROLL 100: NA
Rugged TROLL 200: 8-36 VDC

Memory
Data records’
Data logs

2.0 MB
120,000
Rugged TROLL 100: 1 log; Rugged TROLL 200: 2 logs

Fastest logging rate

1 per second

Fastest output rate

Rugged TROLL 200 only: Modbus & SDI-12: 1 per
second

Log types Linear, Fast Linear, and Event
Sensor Type/Material Piezoresistive; Ceramic
9.0 m (30 ft) (Burst: 18 m; 60 ft)
Range 30 m (100 ft) (Burst: 40 m; 134 ft)
76 m (250 ft) (Burst: 112 m; 368 ft)
Accuracy (FS)* +0.1%
Resolution +0.01% FS or better

Units of measure

Pressure: psi, kPa, bar, mbar, mmHg, inHg Level: in,
ft, mm, cm, m

Temperature Sensor

Accuracy

+0.3°C




Resolution

0.01° C or better

Units of measure

Celsius or Fahrenheit

Warranty

2 years

Footnotes

' Temperature range for non-freezing liquids
*Typical battery life when used within the factory-
calibrated temperature range

* 1 data record = date/time plus 2 parameters
logged (no wrapping) from device within the
factory-calibrated temperature range, 360,000 total
data points

4 Across factory-calibrated pressure and
temperature ranges. Defined as greater than 98% of
all readings fall within spec across temperature and
pressure range Specifications are subject to change
without notice.

Delrin is a registered trademark of E.I. du Pont de
Nemours and Company.

Rugged Baro TROLL specifications

General

Rugged Baro TROLL

Temperature ranges'

Operational: 0-50° C (32-122°F)
Storage: -40-80° C (-40-176° F)
Calibrated: 0-50° C (32-122°F)

Diameter 2.62cm (1.03in.)

Length 14.43 cm (5.68in.)

Weight 137 g (0.30 Ib)

Materials Titanium body; Delrin nose cone, hanger, backend
Output options USB or RS232 via docking station; Modbus/RS485 or

SDI-12 via Rugged TROLL 200 Cable

Battery type & life”

3.6V lithium; 10 years or 2M readings

External power 8-36 VDC
Memory 2.0 MB
Data records® 120,000
Data logs 2 logs

Fastest logging rate

1 per minute

Fastest output rate

Modbus & SDI-12: 1 per second

Log types

Linear

Sensor Type/Material

Piezoresistive; Ceramic




Range 7.0 to 30.0 psi; 0.5 to 2 bar
Accuracy (FS)* +0.1%
Resolution +0.01% FS or better

Units of measure

Pressure: psi, kPa, bar, mbar, mmHg, inHg

Temperature Sensor

Accuracy

+0.3°C

Resolution

0.01° C or better

Units of measure

Celsius or Fahrenheit

Warranty

2 years

Footnotes

' Temperature range for non-freezing liquids
*Typical battery life when used within the factory-
calibrated temperature range.

* 1 data record = date/time plus 2 parameters
logged (no wrapping) from device within the
factory-calibrated temperature range

4 Across factory-calibrated pressure range and
temperature ranges. Defined as greater than 98% of
all readings fall within spec across temperature and
pressure range

Specifications are subject to change without notice.
Delrin is a registered trademark of E.I. du Pont de
Nemours and Company.



Overview

Rugged TROLL overview
The Rugged TROLL 100 and 200 instruments measure pressure, level, and temperature in natural
groundwater and surface water. They also can be used at industrial sites, landfills, and other
installations.

« Both instruments have completely sealed housings that contain an absolute (non-vented) pressure
sensor, temperature sensor, real-time clock, microprocessor, lithium battery, and internal memory.

The Rugged TROLL 100 is designed to hang by a backshell hanger from a suspension wire. The
Rugged TROLL 200 can utilize the backshell hanger or can connect to a cable for easy top-of-
well RS485 communications via laptop computer or mobile device. Additionally, Rugged TROLL
200 cables with stripped-and-tinned cable ends can communicate with data loggers, TROLL Link
Telemetry Systems, or PLC devices via RS485 or SDI-12.

Rugged Baro TROLL overview

The Rugged BaroTROLL measures and logs barometric pressure and temperature in air. This data
is used to correct the Rugged TROLL 100 and 200 data by compensating for barometric pressure
effects during the course of a log.

Communication accessories

Rugged TROLL 100:
« USB or RS232 docking station
Wireless Rugged TROLL COM

Rugged TROLL 100,200 and Rugged BaroTROLL Instruments:
« USB or RS232 docking station
« USB or RS232 Rugged TROLL Com
Wireless RuggedTROLL Com
Software
«  Win-Situ 5 Software or VuSitu mobile app for programming and downloading

« Optional software: Win-Situ Baro Merge for barometric compensation

Other accessories
Rugged TROLL 100
« Suspension cable

Rugged BaroTROLL for logging barometric pressure data



Rugged TROLL 200
« Suspension cable
« Rugged BaroTROLL for logging barometric pressure data
« SDI-12 compatible cable with stripped-and-tinned uphole termination
+ RS485 compatible cable with stripped-and-tinned uphole termination
« RS485 top-of-well cable

« Rugged TROLL 200 cable suspension kit (Use this kit to create a weight-bearing loop capable of
suspending up to 45.5 kg (100 Ibs.) of cable and instrument.)

Equipment configuration table

Data logger Deployment options Communication device

Suspension wire

&—one per Rugged TROLL Wireless Rugged TROLL Com
Rugged TROLL 100 Rugged Baro TROLL Rugged TROLL Docking Station*
—one per network of Rugged TROLLs 99 9
—requires an additional suspension wire
Option (A)
Suspension wire
—one per Rugged TROLL Wireless Rugged TROLL Com
& Rugged TROLL Docking Station*
Rugged Baro TROLL
—one per network of Rugged TROLLs
—requires an additional suspension wire
Option (B)
RS485 Direct-read cable Wireless Rugged TROLL Com
—one per Rugged TROLLs Rugaed TROLL Com®**
Rugged TROLL 200 & 99

—one per cable for top-of-well data

Rugged Baro TROLL —one per network—download only

—one per network of Rugged TROLLs
—requires additional R5485 cable for
real-time data

Option (C)

SDI-12 Direct-read cable Wireless Rugged TROLL Com
& PLC/SCADA

Rugged Baro TROLL &

—one per network of Rugged TROLLs Rugged TROLL Docking Station***
—requires additional SDI-12 cable for
real-time data

* A Rugged TROLL Docking station can connect to one data logger at a time.

** In this deployment option, make sure to include an additional Rugged TROLL Com for real-time data from
the Rugged BaroTROLL.

**¥* |n this deployment option, a Rugged TROLL Docking Station is required for communication with the data
loggers when not connected to the SDI-12 Direct-Read Cable.



Getting started

You will need the following items.
Rugged TROLL 100 or 200 instrument
+  Rugged BaroTROLL (optional)
«  One of the communication devices below

« USB or RS232 docking station and Rugged TROLL Com (for Rugged TROLL 200 and Rugged
BaroTROLL).

«  Wireless Rugged TROLL Com (if using the VuSitu mobile app)

Install software

You can configure and deploy your In-Situ instrument with the VuSitu mobile app or Win-Situ 5 software
for PC. To use Win-Situ, install it from the In-Situ website. Download VuSitu on your mobile device from the
Google Play Store at

play.google.com.

VuSitu Mobile App

VuSitu is the mobile user interface and control application for In-Situ water quality instruments. You can use
VuSitu on mobile devices with Android operating system 4.4, Bluetooth 2.0 and newer. Download the latest
version of the app from the Google Play Store at play.google.com.

VuSitu allows you to accomplish the following tasks.
+ View live readings that update every 10 seconds
Change parameters and units
Set up a data log
« Record data
- Email data in spreadsheet format
Download data to mobile device
Transfer data from mobile device to a computer
« Organize data by Location

« Calibrate Sensors and View Reports

@ To avoid potential compatibility issues, it is important to use the most recent version of the
VuSitu Mobile App. Find version information and app updates from the Google Play Store.

Win-Situ 5 software

1 Click the Win-Situ 5 link and follow the installation instructions.

2 Make sure that you select the option to “Install USB Drivers.”

Win-Situ Baro Merge software

Install Baro Merge Software if you plan to post-correct level data to compensate for barometric pressure.



Connecting Your Instrument to VuSitu

& You must have the VuSitu mobile app to use the instrument with a mobile device. Download
VuSitu from the Google Play Store or the Apple App Store.

Connecting to VuSitu
r © ) N @) o )
. EziEs A < @& Communication Devices H @ Connected Instrument
Setting Up Instrument i e
(J ® 576948 PowerPack Battery: 83% remaining
Level TROLL 400 Instrument Time: :/Zzll\)l\zllu
Attach an instrument To connect to another VuSitu displays the
and turn on the Wireless  instrument, press Connected Instrument
Rugged TROLL Com. Disconnect. VuSitu screen when pairing is
Launch VuSitu. The displays a list of available complete.
app will automatically connections.
connect.
Vusitu Menu Options

The features available in the VuSitu mobile app vary slightly depending on the instrument to which it is
connected. Tap the menu icon in the upper left portion of the screen to view the features included in VuSitu.
Tap the menu icon again to close the menu.

Menu Options when Connected to Instrument

Some features, such as sensor calibration, are not available when you are not connected to an instrument.

O ®d40312

E @ Connected Instrument

| -, LevelTROLL 500
* SN788326

; x Live Readings
|
| Data Files

| Q Locations




Live Readings Screen

The live readings screen displays measurements taken from the instrument every two seconds.
You can save these readings and share them via email or cloud storage.

Snapshot Mode

—D
pH 580pH

< |

pHmV 734mV

{ @2 Live Readings

Aqua TROLL 600 - SN 800837

ORP 381.4mV

5 5 GPS: @
Device Location

RE, “RDING V" _£:
=~ (a 00

Your device's GPS location will be re- orded
with every reading

Yon >

Live Readings Rate: 2 seconds o/

Actual Conductivity 0.05 pS/cm

Tap the button on the
bottom left to toggle
between snapshot and
live readings modes.

Tap Change Location
in the top right corner

if you wish to associate
this data with a different
location.

f [¢]

3:55

—o

N

New Snapshot File Created

@2 Data Files :

EL Snapshot - 2021-02-23 Q

Q  AllLocations

Live Log Snapshot

Device Location
2/23/2021 3:49:39 PM

All Snapshots for today will be stored in
this file.

A new Snapshot file is created each day B
you record a Snapshot reading

5= Snapshot - 2/23/2021

B

2/23/20211:43:16 PM

VuSitu confirms the new  View the file from the

snapshot file. Data Files screen.
Live Readings Mode
pH 5.80pH pH 5.86pH

pHmV 734mV pHmV 69.6mV

ORP 381.4mV ORP 3778 mV

“RDING V' _E: /
ave Single Reading it Rg

~( @ (oo

Tap the button on the
bottom left to switch
from snapshot mode to
live readings mode.

Tap Start Recording.
The instrument takes
a reading every two
seconds.

Aqua TROLL 600 - SN 800837
pH 5.80 pH

Q+ Add Location

pHMV 73.4mV
E Device Location

ORP 381'mv
§ o \ ] / S /
Q Test Sitetidmm (] @ @» . p
/ . . i

=2

Choose the desired
location and press Save
in the bottom right
corner of the screen.

Tap Save Single Reading
to create a snapshot.

pHmV 1647 mV

ORP 403.2mV

RDO Concentration 7.62 mg/L

!7DD uration  105.78 %Sat

L

Tap Stop to end the Tap Save to if you wish to
recording. VuSitu displays share the Live Readings

a summary of the live file via email or cloud
readings data. storage.

J




Chaqgiqg Parameters and Units

pH 5.80pH \ ' /

pHmMV 734mV
L)

ORP 381.4mV

From the Live Readings
screen, tap the settings
wheel next to the

field that contains the
measurement value.

Lalec parare e e ar £

\lz

Terawtvd s @

Tap the parameter drop-
down arrow and tap the
parameter you want to
display.

Downloading and Sharing Your Data

Tap the units drop-down
arrow and tap the unit
you want to display.

Lalec parare e nier an £

Tap the OK button to set
the options and return to
the Live Readings screen.

You can transfer a data file from your mobile device to a PC via Bluetooth, email it to yourself or
any valid email address, or upload it to Google Drive.

Instrument Time: 2:44 PM
2/16/2021

B Live Readin:
g |

N7/
& Looging Q é\
& Calibrafions O

Pair VuSitu with the
instrument. Select
Logging from the
Connected Instrument
screen.

{ @ Logging

Aqua TROLL 600 - SN 800837

<+ New Log

[E AT600800837

Start: 2/10/2021 10:45 AM
Stopped: 2/10/2021 10:46 A

Delete

AT600800837

2/10/20211022 AM

Tap alog and press the
Download button.

220 @ X O0OLR

< @ Download Log File
Aqua TROLL 600 - SN 800837

Device Location
Your device's GPS location will be recorded
with every reading

Change Location >

@ How much data do you want to download?

@® Al data

O only new data

Creates a new datafile

O Specific date range:

Start:

N\

W 2:50 pm

—>
= B N340

(@ Logging

AquaTROLL 600 Vented - SN 458014
(D Leaving this screen may interrupt the download.

Downloading Log File

Choose the data you wish VuSitu displays a

to download. To save the
entire log to your phone,
choose All data.

progress bar while
downloading.



Sharing Data
o —

@ Connected Instrument

J
B\

— )

22 @ Xt OO0 CLR
@ Data Files

< AquaTROLL 600
“ SN 800837

Aqua TROLL 600 - SN 800837
Q  AllLocations

Live Log Snapshot

B Live Read"gs Cancel

DataFile
Q Loc&ns &

& Low-Flow TeSting

| K

Select Data Files from Tap and hold the name Select Export. Choose email, cloud
the menu at the top left  of the log you want to storage, or another
corner of the screen. share. sharing option.

@ To save data locally on your mobile device, export to a third-party file management app.

Viewing Data on a Mac or PC

You'll need to extract your files to view them. To do that on a Mac, double-click the Zip folder.
On a PG, right-click on the folder and choose Extract. Then open your files in Excel.



Connect to the Rugged TROLL Docking Station

The docking station is intended for use with the Rugged TROLL 100, 200 and Rugged BaroTROLL
Instruments that are not deployed with a communication cable. Once connected, you can program the
instrument, view readings, and download the data.

(Y

s

;ﬂ\“ | %

Unscrew and remove Invert the instrument. Place the instrumentinto Connect the docking
the hanger from the Align the notch on the the docking station. station to a computer.
instrument. instrument with the

tab on the rim of the
docking station. This
will ensure that the pins
are aligned to enable
communication.

The hanger is the only removable part of the instrument. Do not attempt to take the
instrument apart. There are no user-serviceable parts in the instrument.

Connect to the Wireless Rugged TROLL Com

The docking station is intended for use with the Rugged TROLL 100, 200 and Rugged BaroTROLL
Instruments that are deployed with a communication cable. Once connected, you can use the VuSitu mobile
app to program the instrument, view readings, and download the data.

o =
e
Connecting
Q&
Unscrew and remove Invert the instrument. Connect the other end of Press the button on the
the hanger from the Align the notch on the the cable to the Wireless ~ Wireless Rugged TROLL
instrument. instrument with the Rugged TROLL Com. Com and open the VuSitu
tab on the rim Rugged Mobile app to pair.

TROLL Cable. This will
ensure that the pins
are aligned to enable
communication.



Connect to the Rugged TROLL Com

The Rugged TROLL Com is used as a communication interface between a Rugged TROLL 200 or a Rugged
BaroTROLL instrument, the Rugged TROLL 200 cable and a computer.

An internal 9 volt battery powers the Rugged TROLL Com, but it does not provide power to the instrument.
The Rugged TROLL Com connects to the uphole end of the Rugged TROLL 200 cable. Once connected, you
can program the instrument, view real-time readings, and download the data.

& Do not submerge the Rugged TROLL Com Device.

Rugged TROLL Com battery installation

Open the battery Attach the battery leads  Push the battery into the

compartment door. to the battery terminals.  compartment and close
the door.

Connections

Attach the Rugged TROLL Connect the Release the connection
Com to the Rugged communication cableto  to the uphole cable end
TROLL 200 cable via the PC. by pushing in the white
snap-on connection to tab on the TROLL Com.

the uphole end of the

cable.

The Rugged TROLL Com requires a minimum of 8 VDC. If you lose connection to the
instrument, particularly when using a long cable, replace the 9V battery on the TROLL Com.



Deploying instruments

You can deploy a Rugged TROLL Instrument with or without a Rugged BaroTROLL Instrument. Use the

Rugged BaroTROLL Instrument when you want to compensate water level measurements for atmospheric
pressure.

Use the following steps for each instrument.

Attach the instrument to a Wireless Rugged TROLL Connect the instrument to a computer and Win-Situ

Com and connect to the VuSitu mobile app. 5 software.
Win-Situ® 5 :
I.-’ =% Device time is not synchronized with the local system.
&Y Sync Now? .
|
Yes Mo | B Live eaain:;s
B Log "I.\(\’.((\
J & colbrations N §
2 3 & lnnmmemseﬂ%/
@ Disconne ect
If you choose to connect with Win-Situ, be sure to Program a log. See the Win-Situ 5 or VuSitu section of
sync the clock. this document for more details.

The BaroTROLL measurements can be taken far apart as long as they cover the general time
period as the Rugged TROLL log.

If the Rugged TROLL log uses the reference “Set first logged reading to," the Rugged BaroTROLL
log should start before the Rugged TROLL log to ensure that barometric pressure is measured
when the first level reading is captured.



& Do not submerge the Rugged BaroTROLL Instrument.

o ©

<D

(5 4

Figure 11.1 Rugged BaroTROLL and Rugged TROLL deployment

1 Pressure due to atmosphere + water column (measured by Rugged TROLL)

2 Pressure due to atmosphere (measured by Rugged BaroTROLL)

Pressure due to water column (calculated by subtracting Rugged BaroTROLL data from Rugged
TROLL data)

4 Rugged BaroTROLL Instrument

5 Rugged TROLL Instrument




Rugged TROLL 200 Cable Suspension

When a Rugged TROLL 200 Instrument or a Rugged BaroTROLL Instrument needs to be installed with a
secure fastener, such as a carabiner, In-Situ Inc. recommends using the Rugged TROLL 200 Cable Suspension
Kit (Part Number 0080880).

When installed correctly the connector can support a combined cable and instrument weight of up to 45.4
kg (100 Ibs).

Create a loop on the Place the metal loop Tighten the zip tie. Place the second zip tie
uphole end of the cable inside the cable loop. directly below the first
and loosely bind it with Push the zip tie up to and tighten.

one zip tie. form a tight band around

the metal loop.

Place the third zip tie Clip the excess tie Deploy from a well dock
about 2.5 cm (1in.) material from the unit. or other secure location.
below the first two ties.

Place the fourth zip tie

snugly against the third.



Wiring connections for stripped-and-tinned cable

The Rugged TROLL 200 Cable can be ordered with stripped-and-tinned wires that can be connected to an
SDI-12 or RS485 data recorder or controller.

SDI-12 connections
+ Blue = serial data
Red =12V power supply
Black = ground
Terminate remaining wires at the data recorder.

SDI-12

Data Logger SDI-12 BLUE

External Power RED

_r

9.6-16 VDC ___

- Ground/Return BLACK

To sensor

-y

@ To learn more about using SDI-12 to communicate with a Rugged TROLL, see the SDI-12
Commands Tech Note on In-Situ’s website.



RS485 connections
+  Red =12V power supply
Black = ground
Green =R5485 (-)
« Blue=RS485 (+)
Terminate remaining wires at the data recorder.

Modbus Master
(RS485 built in)
Digital PLC External Power RED
N
12-36 VDC ____
— |Ground/Return BLACK

RS485 (-) GREEN

R5485 (+) BLUE

To sensor

|

@ To learn more about using RS485 to communicate with a Rugged TROLL, see the In-Situ
Modbus Communication Protocol on In-Situ’s website.



Win-Situ overview

Data tab

When you open Win-Situ 5 Software, the Data tab appears. The left side of the screen contains a file tree
where you can view previously downloaded site data as well as data you have exported to Microsoft Office
Excel. The links on the right side of the screen show where downloaded data are stored on your computer.
The disconnected plug icon in the lower-right corner of the screen indicates that the software is not yet
communicating with an instrument.

File Edit View Tools Preferences Help

Screen element

= o

|| 77 Connections
27 site Data

- 27 Exported Data
L9 Manuals

C:\Users\mcrowell\Documents\WinSitu Data\

Definition

The disconnected plug indicates the instrument is not communicating with the
software. Click to establish communication with a connected instrument.

The connected plug indicates the instrument is communicating with the
software. Click to disconnect the software from the instrument.

The Home tab displays real-time readings from the instrument. When
connection to the instrument is first established, the software displays one
reading of all available parameters in light gray. You must click the Play button
at the bottom of the screen to view real-time readings.

The Logging tab displays a list of logs stored in the connected instrument. When
you click the Logging tab, it can take a moment for the software to retrieve
information from the instrument. (Not applicable for the RDO PRO-X and the
Aqua TROLL 400.)

The Sensors tab lists the sensors in the connected instrument, along with their
serial numbers and the dates of factory calibration and user calibration. Use
the buttons in this tab to calibrate sensors that support user calibration and
configure sensors that are supported by the instrument.

The Device Setup tab allows access to instrument information and settings such
as instrument name, serial number, firmware version, communication settings,
diagnostics, and factory reset options.




Home tab

The Home tab displays real-time readings from a connected instrument. When you first establish
communication, the software displays one reading of all available parameters.

[E Win-Situ® 5 =[O -
File Edit View Tools Preferences Help

& g

=
Level TROLL® 700

! @]san servalo -

22,956 .0.001
Temperature - C Pressure - PSI

-0.002
Depth - ft

Screen element Definition

The Sites button allows you to add, edit, or delete a site. Click the drop-down
arrow next to the button to view the list of sites.

The Device Memory gauge turns yellow when the internal memory is used.
Note: Non-logging instruments do not have internal memory, however, the
gauge shows 100 percent green when power is applied.

The Device Battery gauge turns yellow as the battery is depleted. This
example shows 80 percent of the battery remaining (green) and 20 percent
used (yellow). Note: Non-logging instruments do not have internal batteries,
however, the gauge shows 100 percent green when power is applied.

The Logging Status icon:

Green—The instrument is actively logging data.

Gray—The instrument has no logs pending or running. Non-logging

m instruments always show a gray status icon.

Yellow—The instrument has log data that was collected according to specific
instructions in the “Pending” or

“Suspended” state.




The Alarm icon provides additional instrument status information.
Green—No alarms or warnings

Yellow—One or more warnings

Red—One or more alarms

Move the cursor over the alarm icon to view a description. Click the Device
Setup tab for detailed information on the alarm or warning.

RDO PRO Probe or the Aqua TROLL 400.

-;“J:g B132012 2 8132012
O 111804 AM @ 11:18:04 AM

System Time is displayed on the left. Device Time is displayed on the right.

in red, it differs from the current System Time, and should be synchronized.

use the Set Clock button on the Device Setup tab.

Meter View shows the last known parameter values, displayed with current

real time.

List View is a running list of the most recent records. New readings are

LN N

Graph View shows a real-time trend graph of the selected parameters.

.\‘

(J

The Snapshot button records one set of readings.
@ The Record button logs data to a CSV file that can be opened in a spreadsheet
— program. This is not the same as recording data in a log on the instrument.
Logging tab

The Logging tab displays a list of logs in the instrument. When you click the Logging tab, it may take a
moment for the software to retrieve information from the instrument.

Win-Situ® 5
Fle Edit View Tools Preferences Help

| Level TROLL® 700

i -

| site | Start Time

| Log Narme | Type Scheduled Stop Time | Scop Time Status

I
|

8/30/2013 3:00:00 PV Pending &4

o5
!;Q m _inzar

Note: Disregard the Device Reset alarm for non-logging instruments such as the
Clocks are updated once every two seconds. When the Device Time is displayed
The Time Sync button is used to write the current PC time to the instrument. If

you need to set the instrument clock to a time other than the system (PC) time,

units and time stamp. Readings are sized to occupy the entire screen. This is the
default display in the Home tab. If the type is black, the readings are updating in

continuously added to the top of the list and old readings scroll off the bottom.



Log information

Columns across the Logging screen show information about the logs in the instrument.

Symbol—This is a graphic representation of the information in the Status column.
Site—The site that was specified when the log was configured.

Log Name—The name that was entered when the log was configured.
Type—The logging method that was selected when the log was configured.

Start Time—For a Pending log, the scheduled start time is shown. For a Ready log that has not yet
started, this column displays “Manual.” For a Running or Stopped log, the actual start time is shown.

Scheduled Stop Time—For a log with a scheduled stop, the scheduled stop time is shown. For a log
without a scheduled stop time, this column is blank.

Stop Time—For a Pending or Ready log, this column is blank. For a Running log, the time of the last
data point is shown. For a Stopped log, the actual stop time is shown.

Status—Each log has a specific status. See Log Status for details.

Used Size—Kilobytes of instrument memory allocated for this log. For a Pending or Ready log, the
current size of the log configuration is shown. For a Completed log, the size of the entire log file is
shown. For a Running log, the current size of the log up to the last data point is shown.

Log status

The status of each log in the instrument is displayed in the Logging tab by a symbol beside the log name,
and in the Status column.

.ii.“l |
ot

Ready—Manual Start log is ready to start.

Pending—Scheduled start log is ready to start at its programmed time, or when you click the
Start button.

Running—The log is actively logging data.

Suspended—The log has been paused (stopped temporarily).

Stopped—The log has been stopped, either manually or on a schedule.

Deleted—The log has been marked for deletion and will be deleted from the instrument when
memory is needed. The software manages this automatically.

Invalid—The log as programmed cannot be run.

Ready, Pending, Running, and Suspended logs are considered active. Only one log can be
active in the instrument.



Log control buttons

You can control the status of a log by selecting the log and clicking the appropriate button in the Logging
tab control panel:

W& The Start button starts a Ready or Pending log, or resumes a Suspended log.
Wi The Pause button pauses a Running log allowing you the option to resume it.
N The Restart button restarts the selected Running log from the beginning. This can be useful during

aquifer testing using a logarithmic data collection schedule.

& The Stop button permanently stops the selected Running log.

Log operations

Use the buttons in the control panel to perform the following actions:
“.Ja_‘ Create a new log.

The New button is disabled if a Ready, Pending, Running, or Suspended log is on the instrument. When the
instrument contains its maximum number of logs, the New button is unavailable.

R — Edit (or review) the log configuration for a Ready, Pending, or Invalid log.
__"jﬁ'_% Delete the log. (Note that you must delete a log twice before it is permanently removed.)

_— ) Download the log to a PC.



Sensors tab

The Sensors tab lists the sensors in the instrument, along with their serial numbers and calibration dates. Use
the buttons in this tab to calibrate and configure sensors.

& Win-Situ® 5 i —|olx|

File Edit View Tools Preferences Help

B
@IFGH Collins 1

| Sensar | Serial Number \ Factory Cal Date | Next Factory Cal Date

3... 111860 11/9/2006 10:22;12 AM  11/9/20C 1:05:41 PM

Calibrate

Use the Calibration button to calibrate sensors or to adjust a level reference that is currently stored on the
instrument. The Calibrate button is not available when the instrument does not support calibration (e.g.
BaroTROLL Instrument).

1. With the instrument connected to the software, select the Sensors tab.

2. Select the parameter you intend to calibrate.

3. Click the Calibrate button
Configure
Use the Configure button to select parameter units and to configure parameters that support configuration.
Examples include Level/Depth, Specific Conductivity, and Total Dissolved Solids. Parameters cannot be

configured while the instrument is showing live data on the Home screen or while the instrument contains
an active log.

1. With the instrument connected to the software, select the Sensors tab.
2. Select the parameter you intend to configure.
3. Click the Configure button.

@ When you configure the Level parameter using the Sensors tab, the settings are stored in the
instrument and are available for use in Modbus, SDI-12, or analog communication (if available).
If desired, a different configuration can be selected when setting up a log.



Device setup tab

In general, you should not use the Device Setup tab unless you are corresponding with the In-Situ technical
support team. However, you can use this screen to set up communication protocols if you are connecting
the instrument to a PLC or data logger.

Bawswes _lox|
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Using Win-Situ 5 software
Connecting an instrument to the software

When you open Win-Situ 5 Software, you are asked if you want to connect to your device. Click Yes.
Synchronize the instrument clock to the PC clock.

The software displays an error message if a connection cannot be established.
Selecting the correct COM port

If you are using a USB TROLL Com, select the correct COM port by following the steps below. If you are using
a serial TROLL Com, the Win-Situ Software should default to the correct COM port, which is usually COM 1.

Steps for Windows 8.1 and Windows 10 systems.
1. Right-click the Start button.
2. Click Device Manager.

3. Click the arrow next to Ports (COM and LPT), and locate the USB Serial Port listing. The number listed
next to this entry is your COM port address.

Steps for Windows 8 systems.
1. Right-click the Start screen.
2. Select All Apps.
3. Click Control Panel.
4. Open the Device Manager.
5

Click the arrow next to Ports (Com and LPT), and locate the USB Serial Port listing. The number listed
next to this entry is your COM port address.



Steps for Windows 7 systems.
1. Click the Start button, and open the Control Panel.
2. Click Hardware and Sound, and open the Device Manager.

3. Click the arrow next to Ports (COM and LPT), and locate the USB Serial Port listing. The number listed
next to this entry is your COM port address.

Steps for Windows XP systems.
1. Click the Start button, and open the Control Panel.
2. Double-click the System icon. Click the Hardware tab, and open the Device Manager.

3. Click the plus sign next to Ports (COM and LPT), and locate the USB Serial Port listing. The number
listed next to this entry is your COM port address.

@ The following steps apply for all Windows operating systems.

1. Once you have determined the correct COM port address in your operating system, reopen Win-Situ
5 Software.

2. Close any open windows in Win-Situ Software.

3. Click Preferences.

4. Click Comm Settings, and then click the Port Number menu.

5. Scroll down to find the correct COM port address. Click the check mark to accept the changes.

6. Click the yellow Connect button in the lower right corner to establish a connection to the instrument.

Setting the instrument time

The instrument time and the current PC time are shown at the top of the screen when an instrument is
connected to the software.

-;‘;]'d 8/13/2012 /13,2012
I 11:18:04 AM F11:18:04 AM

The PC time appears on the left, the instrument time on the right. Both clocks are updated at 0.5 Hz (once
every two seconds). The device time is displayed in red if it differs by more than a few seconds from the
current PC time. Data logging schedules depend on a correct instrument time.

To synchronize the instrument time to the current PC time, click the Clock Sync button Win-Situ writes the
current PC time to the instrument.

Adding a new site

To add a new site to the site database in your working directory do one of the following:

On the Data tab, click the Site Data folder, select File> New > Site.

or

On the Home tab, click the Site button to display the site list, then click New . Enter a name for the site. This
is the only required field.

Click Save to save the new site. The new site will appear in the Site Data folder, and Win-Situ will add it to
the site database in the working directory on your computer. It is now available to select for any instrument

log.



Log setup

The Log Setup Wizard presents sequential screens to help you supply all the information necessary to set up
a data log in the instrument.

To access the Log Setup Wizard the instrument must be connected to the software.

1. Click the Logging tab. gl 6

2. Click the New button. | Ei

The New button may be disabled or may show a warning if an active log already exists on
the instrument, or if the instrument is polling live data (see the Home screen), or if the device
already contains its maximum number of logs.

3. Select the Site where the set of data will be logged and supply a name for the log.
4. Click the right arrow to continue after each step.

5. Select the parameters you intend to measure, choose the measurement units, and specify the order
in which the selected parameters will be logged.

Select the logging method you intend to use. See page 35.
Select the log interval. A log interval is how often a measurement will be taken and stored.
Select the start condition, stop condition, and specify how to handle full device memory.

0 o N o

If you selected Level or Depth as a parameter to measure, specify how you intend to log this
parameter.

10. The final screen summarizes the log setup. Click the check mark to write this information to the
instrument.
Logging method descriptions

The following is a list of log types and their descriptions. The log types that are available on an instrument
vary depending upon the capabilities of the instrument.

Linear

Linear log type measures and records at a user-defined fixed interval of one minute or more.
This method is used for long-term studies, landfill monitoring, stream gauging, tidal studies, and
background monitoring prior to aquifer testing. Intervals are measured in days, hours, or minutes.

Event

Linear Event log type combines basic fixed-interval logging of specified parameters with the ability to
log data at a faster interval when a single-parameter event condition is present.



About the level reference

A Level Reference, also called an offset, is a user-specified starting point for logged Level readings. It is
entered in the Logging Setup Wizard when a log is configured, or it can be stored in the device without
configuring a log using the Configure button in the Sensors tab.

Depth mode does not require that you enter a Level Reference.

The Level Reference can be any value you choose. Here are some examples:

« Elevation—If you calculate the water level above mean sea level (MSL) and enter this as the Level
Reference, then elevations above MSL will be logged.

» Depth to Water—If you measure the depth to the water surface (DTW) from the top of the well
casing and enter this as the Level Reference, then DTW (also called drawdown) values will be logged.

« Gauge Height or Stage—Logged readings track water level as related to markings on a nearby staff
gauge.

» Zero—A Level Reference of 0 effectively sets the probe to zero at the start of the log. Changes, both
positive and negative, from the starting water level, will be logged.

Once you have determined the value of your Level Reference, the software gives you three options for
entering it. These control when the level reference is applied.

« New Reference—This option is designed to be used with an active software connection when the
device is installed in the water.

& A new level reference must be entered while the device’s pressure sensor is submerged in its
final position in the water. This is because the current probe reading is set equal to the Level
Reference to create the offset that takes effect at the start of the data log. The log header will
show the probe reading at the time you entered the Level Reference.

During log setup, the software presents two additional options for entering the Level Reference:

« Set first logged reading—Use this option when the instrument will be deployed on wire rather than
cable because you will not be able to communicate with the instrument when it is submerged.

« Remind me to set reference later—Use this option to defer the entry of the Level Reference during
log setup and set a reminder to enter it when the device is submerged in its final position.

Starting a log

Every log is programmed for either a manual or a scheduled start. A log with a manual start time is displayed

in the Logging screen with Ready in the Status column. A log with a scheduled start time is displayed with
Pending in the Status column.

Starting a pending log

A pending log automatically starts at the scheduled time without any user intervention.

A scheduled log with Pending status can be manually started at any time before its scheduled
start.



Starting a manual log

With the instrument connected to the software, select the Logging tab. Select the Ready log you want to
start.

Click the Start Log button. The log starts and the symbol changes. The Status column displays Running.
Suspending (pausing) a Log

A running log may be temporarily paused. For example, you might want to reposition an instrument,
calibrate a sensor, or clean a sensor and later resume the log. A log can be suspended and resumed three
times.

1. With the instrument connected to the software, select the Logging tab

2. Select the log you intend to suspend.

3. Click the Suspend button. Suspended appears in the Status column.
Resuming a suspended log

1. Toresume logging after a log has been suspended, select the Logging tab.

2. Select the Suspended log.

3. Click the Start Log button. Logging resumes. Running appears in the Status column. The data file will
show the time when the log was suspended and the time when it restarted.

Stopping a log

A log can be manually stopped at any time, even if a stop time has been previously scheduled. If you did not
specify a stop condition when you defined the log, the log will run until the instrument is out of memory or
battery power, or until you manually stop it.

A log that has been stopped cannot be resumed. If you intend to resume a log later, you should
suspend a log rather than stop it.

1. To manually stop a log, the instrument must be connected to the software.
2. Select the Logging tab.

3. Select the running log you intend to stop.

4. Click the Stop Log button.

Downloading data to a PC

This procedure copies the data log from the instrument to a PC. It does not remove the data log from
the instrument. After a log is downloaded, it can be exported to a CSV file format that can be used by
spreadsheet programs. The time shown in the log name is the time the log was downloaded.

With an instrument connected, select the Logging tab
Select the log you intend to download.

Choose a Running, Suspended, Stopped, or Deleted log.
Click the Download button.

o h N =

In the next screen, select one of the three download options.
- All data
+ New data (data logged since the last download)

« Time interval to download



New data is downloaded by default to a new log file. To append new data to the last download

of this log, be sure the option “Append logs on download” is selected in the General Settings
dialog (Preferences > General Settings).

6. The log is copied to the connected PC into your Win-Situ working directory folder. View or change
the working directory using File > Settings.

7. At the end of the download, Win-Situ gives you the option of viewing the data.
8. Select Yes and the log is displayed in the Data screen.

9. Select No and the Logging screen appears. You can view the data at any time by selecting it in the
Data tab.

Viewing logged data

To view the data stored in the instrument, you must first download the data. A connection to an instrument
is not needed after the data log has been downloaded.

Select the Data tab.

3. On the left side of the screen, select the log you want to view. To expand a folder shown in the navigation

tree, double-click the folder. The content of the data log is displayed on the right side of the screen in text or
graph format.

@ To switch between view formats, click the Text or the Graph button in the control panel. To
customize the text or graph view, select Preferences > Graph Settings or Preferences > Data
View Settings. These options apply to all downloaded data until you change the options.



Importing VuSitu data to Win-Situ

You can import data files from VuSitu into Win-Situ 5 from the File menu.

(& Win-situ® 5
File Edit View Tools Preferences Help
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Click File > Import VuSitu CSV in the menu bar at the

top of the screen.
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Close Cancel Tmport

Open x
Lookin: [ || VuStuTestles =~ «~®EcrEr
* Name - Date modified Type *
uich sonsg | 2017-10-31.09-32-01 BaroRef Log Log 20T... 11/10/20172:42PM  Chrore
@ 2017-10-31_09-32-01_BaroRef_Log_Log 201.. 11/10/20172:42PM  Chrorr
7l @ 2017-10-31.09-32-01_BaroRef_Log_Log_201... 11/29/2017429PM  Chrorr
Desdes € 2017-11-10_09-07-11_BaroMerge PLC Log_.. 11/10/2017%:36AM  Chrorr
: @ 2017-11-10_09-20-15_BaroMerge PLC_Log_.. 11/10/2017%:41AM  Chrorr
m @ 2017-11-10_09-20-15_BaroMerge PLC Log_.. 11/10/201710.06... Chrom
Libraries @ 2017-11-10_00-30-43_BaroMerge PLC Log_.. 11/10/20171156...  Chromr
o @ 2017-11-10_09-39-43 BaroMerge PLC Log_.. 11/10/201711: Chrorr
=2 @ 2017-11-10_09-45-56 BaroMerge PLC Log_.. 11/10/201710:05... Chrom
This PC @ 2017-11-10_09-45-56_BaroMerge PLC_Log_.. 11/10/201710:06...  Chrorr
@ @ 2017-11-10_09-46-22_PLC_Log_T115 11/10/2017956 AM  Chrarr ,
Network < >
File name [2017-1:31_09-32-01_BaroRef_Log_Log_2017 7| Open
Flesoftyps: [htm Files ("tm) =l Cancel
I Open as readorly

Select the file you wish to import and click Open.
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File Edit View Tools Preferences Help

Select OK at the prompt.

Click on the file name to view it.



Using BaroMerge software

BaroMerge Software is used to post-correct absolute (non-vented) level sensor data to eliminate barometric
pressure effects from the measurements. BaroMerge Software can be accessed through the Win-Situ 5
Software Tools menu. BaroMerge provides three options to correct data.

« Fixed Correction—A single offset value is applied to all selected log data. Use this option if you
know the barometric pressure of the site during the log, and know that it did not change.

« Manual Entry—Specify two or more correction values to apply to the log data. Use this option if
you wish to manually enter a data set of barometric pressure values.
« BaroTROLL log file—Absolute level sensor data points are individually corrected to reflect
barometric pressure changes that were logged by a BaroTROLL instrument during the approximate
time period.
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Baro Merge input—fixed correction

If you select the Apply a fixed correction option, a single correction is applied to all values in the log.

To use this correction method you need barometric pressure values from a reliable source. Choose a single
value that represents the actual ambient barometric pressure during the time period the log was recorded.
You also need to know the file names of the logs you want to correct.

1. From the Tools menu, select Win-Situ Baro Merge.
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Select the Apply a fixed correction option.
Enter the barometric correction value and select units from the drop-down menu.
Click the right arrow button.

Select the log files to which the correction will be applied and click the check mark button.

o vk W

Compensated data files can be viewed or exported from the Data tab.



Baro Merge input—manual entry

When you select the Fixed Correction and Manual Entry options, it is important to know the barometric
pressure for the general time period covered by the log or logs you want to correct.

1. From the Tools menu, select Win-Situ BaroMerge.
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2. Select the Enter one or more values manually option.

3. The compensation table appears that allows you to build a table of barometric data that corresponds to
the time the log was recorded. The compensation table has three preference options:
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The first option, Save calculated barometric adjustments in the new data file(s) is the default
option. It adds additional columns depending on which parameters were selected for the absolute/
non-vented log in the corrected BaroMerge file that uses the compensation table values. This is

intended to show how the adjustments were done in the BaroMerge file. If you do not want to show
these adjustments, clear this option.

«  When the second option, Show time in UTC is selected, the compensation table time stamp
displays in Coordinated Universal Time (UTC) time, formally known as Greenwich Mean Time (GMT).



« If the third option, Ignore daylight saving time (DST) is selected, the compensation table time
stamp format without the daylight savings time adjustment will be shown.

Build a table that contains at least two barometric pressure values.

4
5. Click the right arrow and select the absolute (non-vented) log file or files you intend to correct.
6. Click the check mark and the barometric compensation is applied.

7

Compensated data files can be viewed or exported from the Data tab.

BaroMerge output

Your original log file is not changed. A new, corrected log file with the same name and path is created. The
original “wsl” extension is replaced by “-Baro Merge.wsl".

Disconnecting an instrument from the software

Click the plug icon in the lower-right corner of the screen to disconnect the instrument from the software.
Disconnect the instrument from the communication device. Attach a desiccant pack if you are using a
vented cable.



Maintenance, Cleaning, and Storage

0-ring inspection and replacement

Examine O-rings for wear, dryness, discoloration, stretching, cracks, nicks, and brittleness. Replace O-rings
if one or more of these conditions are present. Replacing O-rings on an annual basis, regardless of their
condition, is the best way to protect against moisture damage.

Perform the following steps to replace an O-ring.
1. Remove and discard the damaged O-ring.
2. Useaclean, dry, soft cloth to clean the O-ring groove to remove dirt or residue.
3. Lubricate the new O-ring using high-vacuum grease.
«  Wash your hands thoroughly.

«  Apply a small amount of grease to the pad of your index finger, and rub your index finger and
thumb together to spread the grease evenly.

+ Inspect the new O-ring and remove any debris stuck to it.
4. Rub your fingers around the O-ring until there is a thin layer of grease on the entire O-ring.

5. Install the O-ring in the groove and remove any excess lubricant with a clean cloth.

& Do not allow water or lubricant to enter the connector.

(leaning the instrument

Clean the instrument body with water and a soft brush or plastic scouring pad, or soak overnight in a mild
acidic solution, such as household vinegar.

& NEVER submerge the connector portion of the instrument when it is not connected to a cable.

If the ports near the pressure sensor are clogged with silt or mud, try the following procedures.
Agitate the instrument vigorously in a bucket of clean water.
« Apply a gentle rinse of water from a wash bottle.

Do not attempt to remove material from the instrument by tapping the instrument against a surface. You
void the instrument’s warranty by inserting anything into the sensor opening. If contamination cannot be
removed using the recommendations above, please contact In-Situ for cleaning.

Storage

Store the instrument in a clean, dry place. Store the instrument where it will not roll off a bench onto a hard
surface or sustain other mechanical shock. Protect the instrument from temperature extremes.
Store the Rugged TROLL within the temperature range -40° C to +80° C (-40° F to +176° F).



Service

Obtaining repair service

If you suspect your system is malfunctioning and repair is needed, you can help assure efficient servicing by
following these guidelines:

1. Call or email In-Situ Technical Support. Have the product model and serial number available.

2. Be prepared to describe the problem, including how the product was used and the conditions noted at
the time of the malfunction.

3. If Technical Support determines that service is needed, they will ask your company to fill out the RMA
form and pre-approve a specified monetary amount for repair charges. When the form and pre-approval is
received, Technical Support will assign an RMA (Return Material Authorization) number.

4. Clean the product as described in the manual.

5. If the product contains a removable battery, remove and retain it unless you are returning the system for
a refund or Technical Support states otherwise.

6. Carefully pack your product in its original shipping box, if possible.
7. Mark the RMA number clearly on the outside of the box.

8. Send the package, shipping prepaid, to:

In-Situ

ATTN: Repairs

221 East Lincoln Avenue

Fort Collins, CO 80524-2533

The warranty does not cover damage during transit. In-Situ recommends insurance for all shipments.
Warranty repairs will be shipped back prepaid.

Outside the U.S.

Contact your international In-Situ distributor for repair and service information.

Guidelines for cleaning returned equipment

Please help us protect the health and safety of our employees by cleaning and decontaminating equipment
that has been subjected to any potential biological or health hazards, and labeling such equipment.
Unfortunately, we cannot service your equipment without such notification. Please complete and sign the
form in your Operator’s Manual (or a similar statement certifying that the equipment has been cleaned and
decontaminated) and send it with each returned instrument.

«  We recommend a cleaning solution, such as Alconox®, which is a glassware cleaning product
available from In-Situ (part number 0029810) or laboratory supply houses.

Clean all cabling. Remove all foreign matter.
Clean cable connector(s) with a clean, dry cloth. Do not submerge cable connectors.

+ Clean the probe body—including the nose cone, cable head, and protective caps. Remove all foreign
matter.



Decontamination and cleaning form

& If an instrument is returned to our Service Center for repair or recalibration without a
statement that it has been cleaned and decontaminated, or if it is the opinion of our Service
Representatives that the equipment presents a potential health or biological hazard, we
reserve the right to withhold service until proper certification is obtained.

Company Name Phone
Address

City State

Instrument Type Serial Number

Contaminant(s) if known)

Decontamination procedure(s) used

Cleaning verified by Title




Declarations of Conformity and Similarity
Rugged TROLL 100

P
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k ./ ’ -S’tu Innovations in Water Monitoring

CE Declaration of Similarity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue, Fort Collins, CO 80524, USA

Declares that performance of each of the following products is equivalent to the Rugged TROLL 200 :
Product name: Rugged TROLL 100

Model: Rugged TROLL 100

Part Number: 0091870

Product Description: The Rugged TROLL 100 is a water depth sensor that is designed for short- or long-
term deployments in wells, lakes, rivers or oceans.

Model Variants: The Rugged TROLL 100 models vary by maximum depth. The models available are: 0-30 ft
(0-9m), 0-100 ft (0-30m) and 0-250 ft (0-76m).

These are in compliance with the following Directives:

e 2014/30/EU EMC Directive

e Restriction of the use of certain hazardous substances in electrical and electronic
equipment (RoHS) Directive, 2011/65/EU and Commission Delegated Directive, (EU)
2015/863

and meet or exceed the following international requirements and compliance standards:

EMC Standard:
EN 61326-1:2021

RoHS Standard:
EN 63000:2018

The CE mark is affixed accordingly.
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David A. Bossie
Regulatory Compliance Manager

In-Situ, Inc.
July 13, 2022

221 East Lincoln Avenue, Fort Collins, CO 80524 USA

WWW.IN-SITU.COM
Toll Free: 800.446.7488  Tel: 970.498.1500  Fax: 970.498.1598

Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval.
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UKCA Declaration of Similarity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue, Fort Collins, CO 80524, USA

We declare that the performance of each of the following products is equivalent to the Rugged TROLL 200:
Product name: Rugged TROLL 100

Model: Rugged TROLL 100

Part Number: 0091870

Product Description: The Rugged TROLL 100 is a water depth sensor that is designed for short- or long-
term deployments in wells, lakes, rivers or oceans.

Model Variants: The Rugged TROLL 100 models vary by maximum depth. The models available are: 0-30 ft
(0-9m), 0-100 ft (0-30m) and 0-250 ft (0-76m).

These products are in compliance with the following Regulations:
e EMC Regulation 2016
¢ Restriction of the use of certain hazardous substances in electrical and electronic
equipment (RoHS) Regulation (S.I. 2012:3032)
and meet or exceed the following British requirements and compliance standards:

e EMC Standard: BS 61326:2021

e RoHS: BS 63000:2018

The UKCA mark is affixed accordingly.
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Regulatory Compliance Manager
In-Situ, Inc.
July 13, 2022

221 East Lincoln Avenue, Fort Collins, CO 80524 USA

WWW.IN-SITU.COM
Toll Free:800.446.7488  Tel: 970.498.1500  Fax: 970.498.1598

Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval.



Rugged TROLL 200
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2 In-Situ

CE Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue, Fort Collins, CO 80524, USA

Declares that the following product:

Product name: Rugged TROLL 200

Model: Rugged TROLL 200

Part Number(s): 0091930, 0091940, 0091950

Product Description: The Rugged TROLL 200 is a water depth sensor that is designed for short- or long-
term deployments in wells, lakes, rivers or oceans.

Model Variants: The Rugged TROLL models vary by maximum depth. The models available are: 0-30 ft (0-
9m), 0-100 ft (0-30m) and 0-250 ft (0-76m).

is in compliance with the following Directive:
e 2014/30/EU EMC Directive
¢ Restriction of the use of certain hazardous substances in electrical and electronic
equipment (RoHS) Directive, 2011/65/EU and Commission Delegated Directive, (EU)
2015/863

and meets or exceeds the following international requirements and compliance standards:

EMC Standards:
EN 61326-1:2021

RoHS Standard:
EN 63000:2018

The CE mark is affixed accordingly.
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David A. Bossie

Regulatory Compliance Manager
In-Situ, Inc.
July 13, 2022

221 East Lincoln Avenue, Fort Collins, CO 80524 USA
Toll Free: 800.446.7488  Tel: 970.498.1500  Fax: 970.498.1598

WWW.IN-SITU.COM

Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval.
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UKCA Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue, Fort Collins, CO 80524, USA

We declare that the performance of the following product:

Product name: Rugged TROLL 200

Model: Rugged TROLL 200

Part Number(s): 0091930, 0091940, 0091950

Product Description: The Rugged TROLL 200 is a water depth sensor that is designed for short- or long-
term deployments in wells, lakes, rivers or oceans.

Model Variants: The Rugged TROLL models vary by maximum depth. The models available are: 0-30 ft (0-
9m), 0-100 ft (0-30m) and 0-250 ft (0-76m).

is in compliance with the following Regulations:
¢ EMC Regulation 2016
e Restriction of the use of certain hazardous substances in electrical and electronic
equipment (RoHS) Regulation (S.I. 2012:3032)
and meets or exceeds the following British requirements and compliance standards:

e EMC: BS 61326-1:2021

e RoHS: BS 63000:2018

The UKCA mark is affixed accordingly.

, .
| A A<
A ST
- \ /
=T T

e ch (EFC

Regulatory Compliance Manager
In-Situ, Inc.
July 12, 2022

221 East Lincoln Avenue, Fort Collins, CO 80524 USA

WWW.IN-SITU.COM
Toll Free: 800.446.7488  Tel: 970.498.1500  Fax: 970.498.1598

Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval.



Rugged BaroTROLL
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2 In-Situ

CE Declaration of Similarity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue, Fort Collins, CO 80524, USA

Declares that performance of each of the following products is equivalent to the Rugged TROLL 200 :
Product name: Rugged Baro TROLL

Model: Rugged Baro TROLL

Product Description: The Rugged Baro TROLL is used to compensate for barometric pressure when using a
water depth sensor that is designed for short- or long-term deployments in wells, lakes, rivers or oceans.
Model Variants: None

These are in compliance with the following Directives:

e 2014/30/EU EMC Directive

e Restriction of the use of certain hazardous substances in electrical and electronic
equipment (RoHS) Directive, 2011/65/EU and Commission Delegated Directive, (EU)
2015/863

and meet or exceed the following international requirements and compliance standards:

EMC Standard:
EN 61326-1:2021

RoHS Standard:
EN 63000:2018

The CE mark is affixed accordingly.
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David A. Bossie

Regulatory Compliance Manager

In-Situ, Inc.
November 15, 2022

221 East Lincoln Avenue, Fort Collins, CO 80524 USA
Toll Free: 800.446.7488  Tel: 970.498.1500  Fax: 970.498.1598

WWW.IN-SITU.COM

Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval.
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UKCA Declaration of Similarity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue, Fort Collins, CO 80524, USA

We declare that the performance of each of the following products is equivalent to the Rugged TROLL 200:
Product name: Rugged Baro TROLL

Model: Rugged Baro TROLL

Product Description: The Rugged Baro TROLL is a barometric pressure sensor used with a water depth
sensor that is designed for short- or long-term deployments in wells, lakes, rivers or oceans.

Model Variants: None

These products are in compliance with the following Regulations:
¢ EMC Regulation 2016
¢ Restriction of the use of certain hazardous substances in electrical and electronic
equipment (RoHS) Regulation (S.I. 2012:3032)
and meet or exceed the following British requirements and compliance standards:

e EMC Standard: BS 61326:2021

e RoHS: BS 63000:2018

The UKCA mark is affixed accordingly.
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Regulatory Compliance Manager
In-Situ, Inc.
November 15, 2022

221 East Lincoln Avenue, Fort Collins, CO 80524 USA
Toll Free: 800.446.7488  Tel: 970.498.1500  Fax: 970.498.1598

Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval.

WWW.IN-SITU.COM
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